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Information in this document is subject to change without notice and does not
represent a commitment on the part of the manufacturer.  No part of this manual may be
reproduced or transmitted in any form or by any means, electronic or mechanical,
including photocopying and recording, for any purpose without the express written
permission of the manufacturer.
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Registered trademarks and trademarks belong to their respective owners.
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Introduction

What is Aqua4Plus?

Aqua4Plus is INW’s easy-to-use Windows-based software for communicating with and
controlling INW’s state-of-the-art Smart Sensors.

Aqua4Plus is designed as a multi-layered control program. The program can control a
number of separate sensors, via cable, radio, modem, or some combination of the three.
Aqua4Plus communicates with INW Smart Sensors using the industry standard
Modbus® communication protocol.

Smart Sensors collect and store data in “sessions.” A session is a preprogrammed series
of steps describing the number of samples to record and the intervals at which samples
are taken. The Aqua4Plus software is used to create and store the sessions on the
sensors and to upload, view and export the collected data.

System Requirements

• Desktop or  laptop computer, running Windows 2000 or higher.

• 256K RAM

• 10 MB free hard drive space

• CDROM drive (Floppy version available on request)

• 9-pin serial port or USB port

• 56K V.92 modem - if using a dial-up modem version of Aqua4Plus

About this Manual

This manual contains in-depth instructions on basic aspects of using Aqua4Plus,
including initial setup, controlling the sensors and retrieving data.

34

Notes:



4

Connecting a Sensor to the Computer

In its cabled configuration, the Smart Sensor cable is terminated with a weather
resistant connector.  In its cableless configuration, the sensor is terminated with a
screw-cap. Remove the screw-cap to access the weather resistant connector. Connect
the weather resistant connector to your PC or laptop serial port via the communication
cable and an RS485/RS232 adapter, as shown below. For USB connections, see
Appendix B.

Figure 1: Connecting a Sensor to the computer
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TION OF SERVICE.   A NEW WARRANTY PERIOD SHALL NOT BE ESTABLISHED FOR
REPAIRED OR REPLACED MATERIAL, PRODUCTS OR SUPPLIES.   SUCH ITEMS
SHALL REMAIN UNDER WARRANTY ONLY FOR THE REMAINDER OF THE WAR-
RANTY PERIOD ON THE ORIGINAL MATERIALS, PRODUCTS OR SUPPLIES.

B.   With respect to products purchased by consumers in the United States for personal use, the
implied warranties including but not limited to the warranties of merchantability and fitness for a
particular purpose, are limited to twelve (12) months from the date of delivery.

Some states do not allow limitations on the duration of an implied warranty, so the above
limitation may not apply to you.   Similarly, some states do not allow the exclusion or limitation
of consequential damages, so the above limitation or exclusion may not apply to you.   This
limited warranty gives you specific legal rights; however, you may also have other rights which
may vary from state to state.
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Installing the Aqua4Plus Software

1. Insert the Aqua4Plus CD in the CDROM drive on your PC or laptop. Installation
should start automatically. If not, then follow steps 2 and 3. Otherwise, skip to
step 4.

2. Click the Start button and select Run.
3. Type D:\setup.exe, where D: is the drive letter for your CDROM drive.
4. The Installation program will guide you through the installation process.

Once the software has successfully completed installation, you can remove the CD from
your CDROM drive and store it in a safe place.

To start the Aqua4Plus software, use the Start Menu to navigate to the program group
you selected during installation (typically this will be Aqua4Plus), and then click the

Aqua4Plus  icon.
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SOFTWARE LICENSE & LIMITED WARRANTY/DISCLAIMER
- Aqua4Plus

SOFTWARE LICENSE. The seller grants the user a non-exclusive license to use
Aqua4Plus (hereafter known as the software), according to the following limitations and
conditions.

The user may install  Aqua4Plus on one or more desktop or laptop computers. All title
and intellectual rights to the software are owned by the seller. No copies may be made or
distributed except as described above. The user may not modify or reverse engineer the
software.

A.   LIMITED WARRANTY. Seller warrants that the software will substantially perform
the functions described in the accompanying written materials for a period of ninety (90)
days from the date of receipt. If the software does not conform to the foregoing war-
ranty, Seller shall, at Seller’s sole and exclusive option, repair or replace the software or
refund to the user a prorated portion of the license fee paid.

Seller warrants that any hardware accompanying the software will be free from defects in
materials and workmanship under normal use and service for a period of one (1) year
from the date of receipt. Seller’s obligation under this warranty shall be limited to
replacing or repairing the part or parts or, at Seller’s option, the products which prove
defective in material or workmanship within ONE (1) year from the date of delivery,
provided that Buyer gives Seller prompt notice of any defect or failure and satisfactory
proof thereof.   Any defective part or parts must be returned to Seller’s factory or to an
authorized service center for inspection.   Buyer will prepay all freight charges to return
any products to Seller’s factory, or any other repair facility designated by Seller.   Seller
will deliver replacements for defective products to Buyer (ground freight prepaid) to the
destination provided in the original order.   Products returned to Seller for which Seller
provides replacement under this warranty shall become the property of Seller.

Seller’s obligations under this warranty shall not apply to any product with (a) is
normally consumed in operation, or (b) has a normal life inherently shorter than the
warranty period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written approval by
the Seller, all warranties are void.   Equipment and accessories not manufactured by the Seller are
warranted only to the extent of and by the original manufacturer’s warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES,
WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY.   IMPLIED
WARRANTIES OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.   SELLER’S
WARRANTY OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER (EXCEPT AS
TO TITLE) ARE SOLELY AND EXCLUSIVELY AS STATED HEREIN.   IN NO CASE WILL
SELLER BE LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR PERFORMED IN
CONNECTION WITH REMOVAL AND REPLACEMENT OF THE SENSOR SYSTEM,
LOSS OF PRODUCTION OR ANY OTHER LOSS INCURRED BECAUSE OF INTERRUP-
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First Time Setup

If you have just installed Aqua4Plus, please take a few minutes to go through the setup
options and configuration.

Options Menu
Use the Options Menu to control settings for the Aqua4Plus software. (Use the
Configure Menu, next page, to control settings for sensors.)

Display Units - Use this option to select the units in which to display
your data. This will control how data is represented on
the Real Time Monitor, the File Display Window, the
Graph Window, and for exported data.

Company Name - This name will print when printing from the File Display
window.

Default Folder - Aqua4Plus saves and looks for files in a default folder.
Use this option to select a default folder location.

Connections - This option is only available if you have a dial-up modem
enabled version of Aqua4Plus. See INW for
further details.

Communication - Use this to set the communications options for communi-
cating with the sensor.

A. From the dropdown Factory Suggested Settings box,
select the type of connection you are using.

B. Set the Lowest and Highest sensor addresses you will
be scanning.

C. If you are using a COM port higher than 4, increase the
Highest COM port to at least that high (maximum of
15).

All other settings will automatically adjust, and you will
rarely need to make changes unless instructed to do so in
a specific sensor / radio / or modem manual.
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Connection using a USB to Serial Adapter
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Figure 2: Communication Options

Change Password - Change the password that is required to enter the
Advanced Setup Menu.

Log Communication
Errors to File - This option turns on error logging.  A file will be kept of all

communication errors.  This log will be saved in the
Default Folder, as chosen under the Options Menu.

Font Size - Use this to increase or decrease the font size on the
sensor tree and the Real Time monitor.
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Appendix B: Using a USB Port

If you do not have or do not want to use a 9-pin serial port for connecting your
sensor to your PC, you can connect to a sensor using a USB port.

Connecting with INW’s USB to RS485 Adapter

If using INW’s USB to RS485 adapter, connect as shown in figure below. Drivers and
installation instructions come with the adapter.

Connection using INW’s USB to RS485 Adapter

Connecting with a USB to Serial Adapter

USB-to-Serial cables are readily available from many electronics and computer stores, as
well as numerous sites on the Internet. INW has tested and recommends the Keyspan
USA-19HS. It is available from INW as well as from many sites on the Internet. Install as
follows:

• Plug into USB port.

• Install the drivers provided with the particular unit.

• Determine the port number to which the adapter is assigned.
 Right-click on My Computer.
 From the popup menu, select Manage to open the Computer Management

window.
 On left panel, click on Device Manager.
 On right panel, double-click on Ports.
 A list of active COM ports will be displayed. Note the COM number assigned

to the adapter you just installed.

For example: 
 Close Manager.

• Connect to the sensor.

• On the Aqua4Plus software, select the COM port noted above. (If you do not see
your new COM port in the dropdown box, open the Communications dialog box
from the Options menu. Increase the Highest COM port number, up to a maximum
of 15.)

PC or Laptop
Computer

USB Port

USB to RS485
Adapter

Sensor
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Configure Menu

Use the Configure Menu to set options on individual sensors. Note that not all options
will be available on all types of sensors. The program determines what sensor you are
connected to and lists configuration items available for that sensor. In order to access
items on the Configure Menu, you must first connect to and select the sensor whose
configuration you want to set. (See Finding, Selecting & Viewing Sensors, page 10.)

Sensor Clock* - A pop-up box displays the date/time currently in the
sensor. Click the Set From System Clock button to set
the sensor clock to match that of your host computer.
Alternately, type in a specific date/time and click the
Set Clock button.

Sensor Description* - Use to enter a description for a particular sensor.
This information is displayed on the Sensor
Window and is recorded with the collected data.

Sensor Address* - If you are connecting several sensors to one
COM port, each sensor must have a unique
address. This is also known as the Modbus address.
Use this option to set the address.

- Addresses must be between 1 and 255. Be sure to set
the Lowest and Highest Sensor Addresses to include all
addresses that you are using (see Options Menu |
Communication.)

Sensor Continuous - Some sensors can take readings more often than once
Rate* per second.  This is known as a “continuous rate.”

Different sensors have different available rates.  Use this
option to select the rate you want to use.  This rate will
be saved to the sensor.

- See the “Creating Session” section on how to set a
continuous rate session.  If this option is not available,
then that sensor does not have continuous rate func-
tionality.

Erase All Sessions - Erases ALL sessions in the currently selected
sensor.

Field Calibration* - Use this option to adjust the calibration on the sensor.
Note that different types of sensors will have different
calibration procedures. Refer to the specific sensor
manual for information on field calibration for that
sensor.

29

Progress information for each sensor will be listed in the status column and overall
progress information will be shown in bold lettering at the lower left of the window.

When the operation is finished, the status column will display the result of the operation
for each sensor. If the sessions were erased successfully, the status column will say
Erased, and then number of sessions on the sensors will display as zero. Click the Close
button to exit the batch processing window.

If any error occurred during the operation, a message box will display at the end of the
operation. Also, the affected sensor will display in red and an error message will display
in the status column. If you want to try again, select the desired sensors, and then click
the OK button; if not, click the Cancel button.

Figure 18: Sessions Successfully Erased
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Advanced

Download Firmware** - Downloads an updated version of the
firmware to the sensor, requires a
password. [Contact INW factory
personnel for details.]

Advanced Calibration* - Requires a password.  Contact INW factory
personnel for details.

Sensor Baud Rate*** - Sets alternate baud rate on sensor – 38400
(default), 19200, or 9600.

Direct Read Units*** - Use to set engineering units when not using
Aqua4Plus.

Radio - This option is only available on radios.  It is used
for setting radios as either remote or host.  Refer
to the WaveData Instruction Manual or contact
INW before using this option.

* Available to view but not change if there are any sessions stored on the sensor.

** Not available if there are any sessions stored on the sensor.

*** Not available on all sensors.
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Figure 16: Sessions Successfully Uploaded

If any error occurred during the operation, a message box will display at the end of the
operation. Also, the affected sensor will display in red and an error message will display
in the status column. If you want to try again, select the desired sensors, and then click
the OK button; if not, click the Cancel button.

Erasing Sessions

To erase sessions from a group of sensors, select Batch Operations from the Session
menu, and then click on Batch Session Erase.

The following batch processing window will display.

Be sure the sensors you want to erase are selected, and then click the OK button.

Figure 17: Batch Erase Window
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Normal Operation

Selecting a Communication Port

Aqua4Plus communicates with the smart sensors via a COM or a USB port on the PC.
When Aqua4Plus is first opened, it polls the computer for all available communication
ports. These are then listed in the connection port drop-down box on the tool bar (figure
3). By default, Aqua4Plus looks for USB and COM 1 through COM 4. If you are using a
higher COM port, specify the highest COM port on the Communications dialog box
under the Options menu.

To select the port you  are using, click on the down arrow, and then click on the port to
which your sensor is connected.

Figure 3: Connection Port Drop-Down Box

Finding, Selecting, and Viewing Sensors

Once the port has been selected, open the Sensor Window by clicking the  tool
button  (or View Menu | Sensor Window). The software will poll the port, looking for
any connected sensors.  A list of connected sensors will appear on the Sensor Tree. If
specific expected sensors do not show up, and you know their addresses, rescan just
those addresses by selecting “Scan Specific Address Range” from the View Menu.

On the Sensor Tree (figure 4), double-click to select a sensor. A list of data sessions
stored on the sensor will be displayed below the sensor. Information regarding the
selected sensor will display in the Sensor Information Panel to the right of the Sensor
Map.

                              Figure 4: Sensor Tree and  Sensor Information Panel

Click here to get
additional details, as
shown below.
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Be sure the sensors from which you want to upload are selected, and then click the OK
button.

You will be asked to select a file folder in which to save your uploaded files. The default
is the folder you have selected as your default folder under the Options menu.

As the files are uploaded, they are named as follows:

sensorname_sessionname_serialnumber.a4d

where:
sensorname = the name you have given to the sensor with the

Sensor Description option under the Configure menu.
sessionname = the name of the session being uploaded
serialnumber = the serial number of the sensor from which the

session is being uploaded.

For example, if you were uploading a session named Overnight from the three sensors
selected in the example above, your three files would be:

Pressure Well 17_Overnight_2901013.a4d
pH Well 17_Overnight_2902054.a4d
Conductivity Well 17_Overnight_2903021.a4d

If there is a session on the disk with the same name as the one you are trying to upload,
Aqua4Plus will check to see if it is actually an earlier upload of the exact same session. If
it is, then Aqua4Plus will upload only those records since that previous upload and
append them to the end of the file. If the file is from a different session, then an error will
be generated, and that file will not be uploaded so as to not overwrite any existing data
on your hard drive.

Progress information for each sensor will be listed in the status column and overall
progress information will be shown in bold lettering at the lower left of the window.

When the operation is finished, the status column will display the result of the operation
for each sensor. If the sessions were uploaded successfully, the status column will say
Session Uploaded.

Sessions are not stopped or erased during an upload operation. Click the Close button
to exit the batch processing window.
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Note that the information shown on the Sensor Tree and the Sensor Panel is static
information. In other words, the program looks at the sensor and displays the informa-
tion, but it does not keep going back to the sensor and getting the newest information.
This is to save battery life on the sensor. To update the information on the Sensor Tree
and the Sensor Panel, click on the “Refresh Selected Sensor” button below the Sensor
Tree. This will requery that particular sensor and update the display.

Sensor Tree:
The Sensor Tree displays a list of all sensors connected to the selected port. If no port
is selected or no sensors are connected to that port, this tree will be empty. The Sensor
Tree is an expanding tree display. Double-click on a sensor to expand the display to
show all sessions, if any, currently stored on that sensor. Click on the  to the left of a
sensor to hide the display of sessions for that sensor.

The different icons in front of each session indicate the current status of that session,
as follows:

   Completed Session - session has run to completion or has been terminated.
   Paused  Session - session has been paused by operator.
   Pending Session - session awaiting a delayed start time.
   Active Session - session currently recording.

Sensor Information Panel:

The top right portion of the Sensor Window displays information pertaining to the
sensor that is selected on the Sensor Tree. This information will vary, depending on the
type of sensor selected. Typical information may include:

Status: Active - sensor is currently recording.
Paused - a recording session has been paused.
Pending - a recording session is awaiting a delayed start

time.
Inactive - No active, paused, or pending sessions.

Sessions: Number of data sessions stored on selected sensor.
Maximum of 60.

Power: Battery or Auxiliary.

Free: Approximate number of records that can be stored
before the sensor memory is full.  Total number of records
varies by sensor type.

Battery: Battery indicator - if Green, the battery is good, if
Yellow, it is low, if Red, it is critically low.  When connected to
auxilliary power, this indicates the battery level of the internal
batteries, not the auxilliary power.
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Error Reporting

If any error occurred during the operation, a message box will display at the end of the
operation. Also, the affected sensor will display in red and an error message will display
in the status column. If you want to try again, select the desired sensors, and then click
the OK button; if not, click the Cancel button.

Uploading Sessions

The batch upload operation uploads the last session on each sensor that is selected in
the batch processing window.

To upload sessions from a group of sensors, select Batch Operations from the Session
menu, and then click on Batch Session Upload.

The following batch processing window will display.

Figure 14: Error in Starting Sessions

Figure 15: Batch Upload Window
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To view further details, click the ellipsis  in the upper right corner for a drop-down
information panel. Typical information for this drop-down panel may include:

Sensor Description: User assigned description. (Set this description on the
Configuration Menu | Sensor Description Option.)

Sensor Type: Factory assigned sensor type.

Modbus: This is the assigned Modbus address for the sensor.
Each sensor on a COM port must have a unique
Modbus address. This address must be between 1 and 255.
(Set this address on the Configure Menu | Sensor Address.)

Serial Number: Factory set sensor serial number.

Firmware Revision: Sensor firmware revision number.

Range/Element: Sensor range and element information may also be displayed.

Using the Real Time Monitor

Figure 5: Real Time Monitor

Use the Real Time Monitor (lower part of Sensor Window) to view live readings from the
sensor that is selected on the Sensor Tree. These readings are not being recorded in the
sensor, but only displayed for real time viewing. The Real Time Monitor can be used
whether or not the sensor is actively recording a session.

To obtain and display a single reading, click the Single button.

To obtain and display readings continuously for 60 readings, click the Start button.
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Be sure the sensors on which you want to start sessions are selected, and then click the
OK button. When you click OK, several things happen.

• Current status is gathered from each sensor.

• Available memory space is checked on each sensor.

• The clocks are reset (if so specified in profile).

• The profile information is downloaded to each sensor.

• The Start command is issued to each sensor.

Progress information for each sensor will be listed in the status column and overall
progress information will be shown in bold lettering at the lower left of the window.

Notes:
• If you checked the Set Sensor Clocks option in the profile, all sensor clocks will be

set to the current time on the computer running Aqua4Plus just before the session
is started. All clocks will be set at the top of a second. When using a radio or
modem network, there will be a communication time lag. It is to be noted that the
clocks may not be as closely synchronized as when this command is sent via a
direct connection.

• If you selected a delayed start time in the profile, all session profiles will be sent to
the sensors, and the sessions will start at the appointed times. If the appointed time
has passed before all the profiles have been loaded to the sensors, an error will be
generated. See Error Reporting on next page.

• If you did not select a delayed start time, each sensor will be started in turn at the
top of the next second. When directly connected, this results in each sensor
starting one second after the previous one. When using a radio or modem network,
the delay between session starts on the sensors will be somewhat more. If it is
important that the sessions start at the same time, you must use the delayed start
feature.

When the operation is finished, the status column will display the result of the operation
for each sensor. If the sessions were started successfully, the status column will say
Session Started, and the number of sessions on the sensors will be updated. Click the
Close button to exit the batch processing window.

Figure 13: Sessions Successfully Started
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To stop the monitor, click the Stop button.

The Monitor displays a column for the sensor date/time and for each parameter being
collected. Use the horizontal and vertical scroll bars as needed to adjust the view.
Readings are displayed in the units selected from the Options Menu. For example,
pressure might be displayed in psi or in Ft  H2O, or something else. (See page 6 for
details on the Options Menu.)

Using Sessions

The Smart Sensor collects and stores data in “sessions.” A session is a preprogrammed
series of steps describing the number of samples to record and the sampling intervals.
Several sessions can be in the Smart Sensor memory at any one time, several completed
sessions (along with their data) and one active session. An active session can be either
recording, paused, or pending (waiting for a delayed start time). The maximum number of
sessions and the maximum number of records that can be stored depends on the type of
sensor. Check your sensor documentation for details.

The Session Profile Window is used to create and/or view session profiles. A session
profile is a description of the test steps necessary for a particular test. Session profiles
can be saved to disk for later use or downloaded to a sensor. Note: there can only be
one active session on a sensor. Once a new session is downloaded, any currently active
session is terminated and the new session becomes the active session. All previous
sessions on the sensor are retained, along with their data, until erased, but can not be
run again.

          Figure 6: Session Window
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Continuous Polling Interval
When using batch processing, the goal is to have each sensor record for the same amount of
time, with each phase lasting the same length of time from one sensor to the next. This makes
it easy to compare data from various different sensors.

Most AquiStar® Smart Sensors can be set to a continuous polling interval. This interval varies
from sensor to sensor and can be set on any particular sensor by selecting the Sensor Continu-
ous Rate under the Configure menu.

Due to the fact that sensors may have different continuous rates, if you want to set a phase in
your profile to be continuous in batch mode, you will need to specify the phase duration for
that phase, rather than specifying how many records will be recorded during that phase. The
minimum phase duration is 10 seconds.

To indicate that a phase is a continuous phase, enter a letter C in the polling interval. The
phase information will display as follows:

Enter the Phase Duration as dd/hh:mm:ss. When the session is downloaded to the sensor during
the starting process, the program will determine the correct number of records for that sensor
to record to match the phase duration you have set.

Batch Processing Window

Figure 12: Batch Session Start Window
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Creating Sessions:

1. Create a new session  by clicking the  tool button (or Session Menu | New).
A Session Profile Window will open with a new session profile.

2. If you want to open a previously saved session profile, click the  tool button
(or File Menu | Open), and then select the profile you want. If you are satisfied
with this profile, skip to step 8. Otherwise, continue with the following steps.

3. Name your session by entering a name in the Session ID box, or leave as is to
accept the default name.

4. Describe test phases. Each session consists of up to 10 test phases. During
data collection, these phases will be executed one after the other in sequence.
Each phase can have different polling intervals and/or number of records. For
example, you might want to record a reading every five seconds for 100
records, every 30 seconds for 100 records, and then every five minutes for the
next 1000 records.  The length of each phase shows in the right-hand column.
The recording length for the entire session shows at the bottom of the window.

To describe a test phase:
• Click in the Polling  Interval column for the first phase.

• Enter your polling interval for this phase as dd/hh:mm:ss, where “dd” is
number of days, “hh” is number of hours, “mm” is number of minutes, and
“ss” is number of seconds between recordings. You only need to enter the
smallest time interval you are using. For example, if you want a sample
recorded every 10 seconds, you only need to enter 10 and then press the
Tab key. The days, hours, and minutes will default to zero. Likewise, if you
want a sample recorded every hour, you would enter 01:00:00, and the
days would default to zero.

Some sensors can take readings more often than once per second.  This is
known as a “continuous rate.”  Different sensors have different available
rates.

To use the continuous rate for a particular phase, enter the letter ‘c’ in the
polling interval rather than a specific time interval.  The sensor will then use
the rate that had been saved on the sensor using the Sensor Continuous
Rate option on the Configure menu.

• Enter the number of records to record at this polling interval.

• Press the Tab key and continue entering phases, as desired.
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Figure 11: Batch Session Profile Window

You can load and modify a saved profile or create a new one. If you want to open a
previously saved session profile, Click the Open button, and then navigate to the saved
profile.

Session ID: Enter a name for your session. This name will be part of the final uploaded
name – see details on file naming in the Uploading Sessions section below.

Delayed Start: If you want all your sensors to start at exactly the same time, enter a
delayed start time here. Be sure to select a time far enough in the future to allow the
session information to be broadcast to all sensors prior to that time. With directly
connected sensors, this time should not be more than a minute or two. With radio or
modem networks, this time may vary greatly. An error message will display if the session
information is not sent to all the sensors before the set delayed start time.

Set Sensor Clocks: Checkmark this box, if you want Aqua4Plus to reset the clocks on all
the sensors prior to starting the sessions. (The clocks will be set to the time on the
computer running Aqua4Plus. This is recommended, so that your collection times will
match from one sensor to another.)

Phase Information: Describe your session collection intervals and number of records, as
desired. (Note: if using a continuous interval, see Continuous Polling Interval below.)

Save As: If you want to save this profile to disk before loading to the sensors, click the
Save As button now.

Select Sensors: Once you have defined your profile, click the Select Sensors button.
This window will close and the batch processing window will display, as shown in
Figure 12.
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5. If desired, select Delayed Start: Click the Delayed Start checkbox. Enter the
date and time to start. Time is in 24 hour format. This option is especially useful
when you want to collect and compare data from several sensors. Create a
profile, save it to disk. Connect to each sensor in turn and download the test to
that sensor. Note: For accurate data, be sure the clocks in all the sensors have
been set to the same time. (See page 7 for details on setting the clock.)

Entering Date:  Click on the day, month and year and enter the desired start
date.  To select from a calendar, click on the down-arrow next to the date and
time.  Select your start date from the calendar.
Entering Time:  Click on the hours, minutes, and seconds and enter the desired
start time.

Note on Date:  Internally in the sensor, only the day of the month is stored.
The session will start the next time the day of the month matches the day of the
month you selected - regardless of the month!  For example:  Suppose you
select January 8th as your start date.  The sensor will start the first time the day
of the month is equal to 8.  If today is January 5th, then it will start on January
8th.  If today is January 20th, it will start on February 8th.

6. If desired, save the session to disk for future use: Click the  tool button (or
File Menu | Save), enter a file name or leave as is to accept the Session ID as
the file name, then click the Save button.

7. Download session to the sensor: Once you are satisfied with the session
profile or setup, you must download the session to the sensor. To do this, click
the Start button.  If you selected a delayed start time, the sensor will wait until
the specified time and then begin collecting data, otherwise data collection will
begin immediately.  (Note: Downloading a session to the sensor will terminate
any active, paused, or pending session.)

Pausing and Resuming Sessions:

You can manually pause and resume the active session on the sensor. To pause, click on
the active session on the sensor map. (The active session will have a green icon  in
front of the session name.) Once the session has been selected, open the Session Menu
and select Pause. A hand icon  will display in place of the green icon.

To resume a paused session, click on the paused session to select it. Open the Session
Menu and select Resume. The hand icon will once again change to a green icon. Note:
you cannot resume a terminated or finished session, one with a blue checkmark .
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Accessing Batch Operations

The Batch Operations commands are located on the Session Menu. Click on Batch
Operations and a fly out menu will list the available options.

Each batch operation will display a batch processing window, as shown below:

All sensors that are on the main Aqua4Plus sensor window will display in the batch
processing window. Each sensor has a checkbox in front of it, allowing you to select
which sensors will be part of the batch operation. All boxes are checked when the
window opens. Select or deselect individual sensors by clicking the checkbox. You can
also select all the sensors or deselect all the sensors by clicking the respective buttons
at the top of the form.

The batch processing window displays sensor information for each sensor, including
sensor type, sensor name, sensor address, and the number of sessions currently on the
sensor. There is also a status column, which displays the progress and status of a batch
operation, including any error messages that might be generated.

Starting Sessions

The Session Profile

To start a new session on a group of sensors, select Batch Operations from the Session
menu, and then click on Batch New Session. The following session profile window will
display.

Figure 10: Batch Processing Window
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Terminating a Session:

Any active session (running , paused , or pending ) can be terminated manually
at any time. On the Session Tree, click on the session to select it. Open the Session
Menu, and then select Terminate. The icon will be replaced by a blue checkmark .

Erasing Sessions:

To erase the sessions and their data from the Smart Sensor, open the Config or Session
Menu, and then select Erase All Sessions. You cannot erase individual sessions. Erasing
deletes ALL sessions on the sensor. Be sure you have uploaded all important data
before erasing the sessions.

Retrieving Data

• If the sessions are not displayed on the Sensor Tree, double click on the sensor
from which you will be uploading.

• Click on the session you want to upload.

• Click the   tool button. The Save dialog box displays.

• Enter a file name or leave as is to save with the Session ID as the file name.

• Select a file type (optional). Uploading always saves the data in the Aqua4Plus
Data File (.a4d) format. Files can additionally be saved in either Text (.csv) or
Excel (.xls) formats. Select the file type from the drop-down Save-as-type box.
(.xls formatted files can be opened in Excel. .csv formatted files can be opened in
Excel and most other popular spreadsheets, databases, and word processors.)

• Click the Save button.

• Click Start.

• When upload is complete:

 If you uploaded in only the Aqua4Plus Data File (.a4d) format, you can now
click on the Done button to close the upload box, or you can click on the View
button to view the data in the File Display window. (See more details on the
File Display window in the next section.)

 If you uploaded in Text (.csv) or Excel (.xls) format, the file will automatically
be opened in the File Display window, and you will also be given the option of
viewing it in Excel. (Note, you must have Excel installed on your machine in
order to make use of this option.)
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• Using the File Display window, open the file you want to export.

• Click on the   tool button.

• Select a file location and enter a name for the file or leave as is to accept the
current file name.

• Select a file type. Files can be saved in either Text (.csv), the default, or Excel
(.xls) formats. Select the file type from the drop-down Save-as-type box. (.xls
formatted files can be opened in Excel. .csv formatted files can be opened in
Excel and most other popular spreadsheets, databases, and word processors.)

• Click Save. You will be given the option of viewing it in Excel. (Note, you must
have Excel installed on your machine in order to make use of this option.)

Importing Data Into a Spreadsheet

To import data to a spreadsheet or database, you must first Upload and Export the data
to a .csv or .xls file. (See previous sections on uploading and exporting.) Most spread-
sheets and databases can readily import .csv files. Microsoft® Excel can import either
.csv or .xls files.  Following are instructions for importing a data file into Excel. For
importing into other programs, see documentation with the particular program.

1. Open Excel.
2. Click on the File menu, and the select Open.
3. On the Open dialog box, click the down-arrow to the right of the Files of Type

field. (This is the last field on the dialog box.)
4. Click the option All Files.
5. Navigate to the saved file, and then click the Open button in the lower right

corner of the dialog box.

The data will be opened in Excel. (Note: While Aqua4Plus can handle over 130,000
records, Excel is limited to approximately 65,000 records.)

 Appendix A: Batch Operations

Aqua4Plus can start sessions on several sensors with a single command.  Likewise,
sessions can be uploaded and/or erased on several sensors at once.  This functionality
works on AquiStar®  PT2X, CT2X, and TempHion Smart Sensors.  (PT2Xs must have
firmware 0.22 or higher.)  It will work via modems and WaveData®  radios, as well as via
direct connection.
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Viewing Data

Aqua4Plus displays collected data in both a tabular format and a graphing format.
 (See figures 7 and 8 on next two pages.)

Displaying Data in Tabular Format:

Click on the file display icon  (or View Menu | File Display Window) to open the File
Display Window. This window displays data that has been uploaded to a disk file (files
with an extension of .a4d). Navigate to the desired file, and then click the Open button.

The File Display Window consists of two panels. The top panel displays various
information about your data, such as number of records, session name, sensor name,
etc.

The lower panel displays the actual data. The first few rows display statistical data
about your records, including minimum, maximum and mean values for both pressure
and temperature, as well as the variance, standard deviation, and field calibration values.
The remaining rows display the actual data.

                              Figure 7: File Display Window
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6. Grid Line - Enable grid lines for any particular parameter.
Note:  Grid lines only show on the graph when the grid
lines tool button is depressed.

7. Plot Color - Click to change color for any particular parameter.  Click
the color under grid to change the grid line color for that
parameter.

Click to add notes to your graph. You can add up to 500 words below the
graph. If this button is selected, they will be printed with the graph and can be
copied and pasted into other documents. (See note at  on page 19 about
limitations on copying and pasting.)

Click to display statistics below the graph (min, max, mean, variance, standard
deviation, and field calibration values). If this button is selected, they will be
printed with the graph and can be copied and pasted into other documents.
(See note at  on page 19 about limitations on copying and pasting.)

Click to turn grid lines on or off.  Only grid lines enabled on the display setup
will show.

Click to turn discrete points on or off.

Click to change from color to black and white. Some printers print better in plain
black and white.

Click to change the size, color, and style of the font. Note that size and style
affect all fonts on the graph, while color affects only the title.

Click to zoom in. Cursor will change to an arrow with an attached box. Click and
drag to enclose the area you want to zoom.

Click the down arrow to right of icon to select scale:
• Full Scale - Minimum and Maximum scales set to full scale for ALL

parameters on the sensor whose data is being displayed.
(Set individual parameters, if desired, under Display
Setup .)

• Data - Minimum and Maximum scales set to minimum and
maximum data values for ALL parameters in the displayed
data file. (Set individual parameters, if desired, under
Display Setup .)

• User - Select the user defined Minimum and Maximum scales

specified under Display Setup .
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To print your data, click the File menu and select Print. Be warned - large files will
consume large amounts of paper!

Click on the graph icon  to switch to graphing view. You can switch back to the

tabular view by clicking on the file display icon .

Displaying Data in Graphing Format:

Figure 8: Graphing Window

Click on the graphing icon  (or View Menu | File Graphing Window) to open the
Graphing Window. This window displays data that has been uploaded to a disk file (files
with an extension of .a4d). Navigate to the desired file, and then click the Open button.

The graphing window is a free-floating window and can be placed outside the main
Aqua4Plus window frame. It is often easier to view the graph with the graphing window
maximized. Click the maximize button  in the upper right corner of the graphing
window to view in maximized mode.

Click to open a new file. (Alternate = File Menu | Open)

Click to export the graph as a graphic file (.jpg, .gif, .bmp, or .png).
(Alternate = File Menu | Export Graph)
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Click to print the graph. What is seen on the screen will be printed – i.e., if
notes or statistics are turned on, they will print. If the graph is zoomed in, it will
print only the area showing on the screen.

Click to copy and paste to the Window’s clipboard. When pasting from the
clipboard into another program, exactly what is pasted will depend on the type
of program. If pasting into a graphics or paint program, only the graph will
paste. If pasting into a text only program, such as Notepad, only the notes and
statistics (if turned on) will paste. If pasting to a multi-purpose program, such
as Word, everything that is turned on will paste.

Click to open the Display Setup dialog box and change various display
attributes.

Figure 9: Graph Display Setup

1. Parameter - Lists all parameters available to be plotted for the
particular data file.

2. Plot - Click to toggle whether or not to plot any particular
parameter. Note: Time is always plotted and is always
along the bottom of the graph.

3. Legend Position- The legend for any parameter (except Time) can be
displayed either to the left or to the right of the graph.
Click here to toggle between left and right.

4. Scale Limits - Click to rotate among the following options:
• Full Scale - Minimum and Maximum scales set to full scale for that

parameter on the sensor whose data is being displayed.
• Data - Minimum and Maximum scales set to minimum and

maximum data values for that parameter in the displayed
data file.

• User - User defined Minimum and Maximum scales.
5. Scale Min/Max - Displays current Minimum and Maximum scale values.

Click and type in these boxes to change values for User
defined scales.
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To print your data, click the File menu and select Print. Be warned - large files will
consume large amounts of paper!
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tabular view by clicking on the file display icon .

Displaying Data in Graphing Format:

Figure 8: Graphing Window

Click on the graphing icon  (or View Menu | File Graphing Window) to open the
Graphing Window. This window displays data that has been uploaded to a disk file (files
with an extension of .a4d). Navigate to the desired file, and then click the Open button.

The graphing window is a free-floating window and can be placed outside the main
Aqua4Plus window frame. It is often easier to view the graph with the graphing window
maximized. Click the maximize button  in the upper right corner of the graphing
window to view in maximized mode.

Click to open a new file. (Alternate = File Menu | Open)

Click to export the graph as a graphic file (.jpg, .gif, .bmp, or .png).
(Alternate = File Menu | Export Graph)

19
Click to print the graph. What is seen on the screen will be printed – i.e., if
notes or statistics are turned on, they will print. If the graph is zoomed in, it will
print only the area showing on the screen.

Click to copy and paste to the Window’s clipboard. When pasting from the
clipboard into another program, exactly what is pasted will depend on the type
of program. If pasting into a graphics or paint program, only the graph will
paste. If pasting into a text only program, such as Notepad, only the notes and
statistics (if turned on) will paste. If pasting to a multi-purpose program, such
as Word, everything that is turned on will paste.

Click to open the Display Setup dialog box and change various display
attributes.

Figure 9: Graph Display Setup

1. Parameter - Lists all parameters available to be plotted for the
particular data file.

2. Plot - Click to toggle whether or not to plot any particular
parameter. Note: Time is always plotted and is always
along the bottom of the graph.

3. Legend Position- The legend for any parameter (except Time) can be
displayed either to the left or to the right of the graph.
Click here to toggle between left and right.

4. Scale Limits - Click to rotate among the following options:
• Full Scale - Minimum and Maximum scales set to full scale for that

parameter on the sensor whose data is being displayed.
• Data - Minimum and Maximum scales set to minimum and

maximum data values for that parameter in the displayed
data file.

• User - User defined Minimum and Maximum scales.
5. Scale Min/Max - Displays current Minimum and Maximum scale values.

Click and type in these boxes to change values for User
defined scales.



17

Viewing Data
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 (See figures 7 and 8 on next two pages.)
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about your records, including minimum, maximum and mean values for both pressure
and temperature, as well as the variance, standard deviation, and field calibration values.
The remaining rows display the actual data.
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• User - Select the user defined Minimum and Maximum scales
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Terminating a Session:

Any active session (running , paused , or pending ) can be terminated manually
at any time. On the Session Tree, click on the session to select it. Open the Session
Menu, and then select Terminate. The icon will be replaced by a blue checkmark .

Erasing Sessions:

To erase the sessions and their data from the Smart Sensor, open the Config or Session
Menu, and then select Erase All Sessions. You cannot erase individual sessions. Erasing
deletes ALL sessions on the sensor. Be sure you have uploaded all important data
before erasing the sessions.

Retrieving Data

• If the sessions are not displayed on the Sensor Tree, double click on the sensor
from which you will be uploading.

• Click on the session you want to upload.

• Click the   tool button. The Save dialog box displays.

• Enter a file name or leave as is to save with the Session ID as the file name.

• Select a file type (optional). Uploading always saves the data in the Aqua4Plus
Data File (.a4d) format. Files can additionally be saved in either Text (.csv) or
Excel (.xls) formats. Select the file type from the drop-down Save-as-type box.
(.xls formatted files can be opened in Excel. .csv formatted files can be opened in
Excel and most other popular spreadsheets, databases, and word processors.)

• Click the Save button.

• Click Start.

• When upload is complete:

 If you uploaded in only the Aqua4Plus Data File (.a4d) format, you can now
click on the Done button to close the upload box, or you can click on the View
button to view the data in the File Display window. (See more details on the
File Display window in the next section.)

 If you uploaded in Text (.csv) or Excel (.xls) format, the file will automatically
be opened in the File Display window, and you will also be given the option of
viewing it in Excel. (Note, you must have Excel installed on your machine in
order to make use of this option.)
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• Using the File Display window, open the file you want to export.

• Click on the   tool button.

• Select a file location and enter a name for the file or leave as is to accept the
current file name.

• Select a file type. Files can be saved in either Text (.csv), the default, or Excel
(.xls) formats. Select the file type from the drop-down Save-as-type box. (.xls
formatted files can be opened in Excel. .csv formatted files can be opened in
Excel and most other popular spreadsheets, databases, and word processors.)

• Click Save. You will be given the option of viewing it in Excel. (Note, you must
have Excel installed on your machine in order to make use of this option.)

Importing Data Into a Spreadsheet

To import data to a spreadsheet or database, you must first Upload and Export the data
to a .csv or .xls file. (See previous sections on uploading and exporting.) Most spread-
sheets and databases can readily import .csv files. Microsoft® Excel can import either
.csv or .xls files.  Following are instructions for importing a data file into Excel. For
importing into other programs, see documentation with the particular program.

1. Open Excel.
2. Click on the File menu, and the select Open.
3. On the Open dialog box, click the down-arrow to the right of the Files of Type

field. (This is the last field on the dialog box.)
4. Click the option All Files.
5. Navigate to the saved file, and then click the Open button in the lower right

corner of the dialog box.

The data will be opened in Excel. (Note: While Aqua4Plus can handle over 130,000
records, Excel is limited to approximately 65,000 records.)

 Appendix A: Batch Operations

Aqua4Plus can start sessions on several sensors with a single command.  Likewise,
sessions can be uploaded and/or erased on several sensors at once.  This functionality
works on AquiStar®  PT2X, CT2X, and TempHion Smart Sensors.  (PT2Xs must have
firmware 0.22 or higher.)  It will work via modems and WaveData®  radios, as well as via
direct connection.
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5. If desired, select Delayed Start: Click the Delayed Start checkbox. Enter the
date and time to start. Time is in 24 hour format. This option is especially useful
when you want to collect and compare data from several sensors. Create a
profile, save it to disk. Connect to each sensor in turn and download the test to
that sensor. Note: For accurate data, be sure the clocks in all the sensors have
been set to the same time. (See page 7 for details on setting the clock.)

Entering Date:  Click on the day, month and year and enter the desired start
date.  To select from a calendar, click on the down-arrow next to the date and
time.  Select your start date from the calendar.
Entering Time:  Click on the hours, minutes, and seconds and enter the desired
start time.

Note on Date:  Internally in the sensor, only the day of the month is stored.
The session will start the next time the day of the month matches the day of the
month you selected - regardless of the month!  For example:  Suppose you
select January 8th as your start date.  The sensor will start the first time the day
of the month is equal to 8.  If today is January 5th, then it will start on January
8th.  If today is January 20th, it will start on February 8th.

6. If desired, save the session to disk for future use: Click the  tool button (or
File Menu | Save), enter a file name or leave as is to accept the Session ID as
the file name, then click the Save button.

7. Download session to the sensor: Once you are satisfied with the session
profile or setup, you must download the session to the sensor. To do this, click
the Start button.  If you selected a delayed start time, the sensor will wait until
the specified time and then begin collecting data, otherwise data collection will
begin immediately.  (Note: Downloading a session to the sensor will terminate
any active, paused, or pending session.)

Pausing and Resuming Sessions:

You can manually pause and resume the active session on the sensor. To pause, click on
the active session on the sensor map. (The active session will have a green icon  in
front of the session name.) Once the session has been selected, open the Session Menu
and select Pause. A hand icon  will display in place of the green icon.

To resume a paused session, click on the paused session to select it. Open the Session
Menu and select Resume. The hand icon will once again change to a green icon. Note:
you cannot resume a terminated or finished session, one with a blue checkmark .
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Accessing Batch Operations

The Batch Operations commands are located on the Session Menu. Click on Batch
Operations and a fly out menu will list the available options.

Each batch operation will display a batch processing window, as shown below:

All sensors that are on the main Aqua4Plus sensor window will display in the batch
processing window. Each sensor has a checkbox in front of it, allowing you to select
which sensors will be part of the batch operation. All boxes are checked when the
window opens. Select or deselect individual sensors by clicking the checkbox. You can
also select all the sensors or deselect all the sensors by clicking the respective buttons
at the top of the form.

The batch processing window displays sensor information for each sensor, including
sensor type, sensor name, sensor address, and the number of sessions currently on the
sensor. There is also a status column, which displays the progress and status of a batch
operation, including any error messages that might be generated.

Starting Sessions

The Session Profile

To start a new session on a group of sensors, select Batch Operations from the Session
menu, and then click on Batch New Session. The following session profile window will
display.

Figure 10: Batch Processing Window
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Creating Sessions:

1. Create a new session  by clicking the  tool button (or Session Menu | New).
A Session Profile Window will open with a new session profile.

2. If you want to open a previously saved session profile, click the  tool button
(or File Menu | Open), and then select the profile you want. If you are satisfied
with this profile, skip to step 8. Otherwise, continue with the following steps.

3. Name your session by entering a name in the Session ID box, or leave as is to
accept the default name.

4. Describe test phases. Each session consists of up to 10 test phases. During
data collection, these phases will be executed one after the other in sequence.
Each phase can have different polling intervals and/or number of records. For
example, you might want to record a reading every five seconds for 100
records, every 30 seconds for 100 records, and then every five minutes for the
next 1000 records.  The length of each phase shows in the right-hand column.
The recording length for the entire session shows at the bottom of the window.

To describe a test phase:
• Click in the Polling  Interval column for the first phase.

• Enter your polling interval for this phase as dd/hh:mm:ss, where “dd” is
number of days, “hh” is number of hours, “mm” is number of minutes, and
“ss” is number of seconds between recordings. You only need to enter the
smallest time interval you are using. For example, if you want a sample
recorded every 10 seconds, you only need to enter 10 and then press the
Tab key. The days, hours, and minutes will default to zero. Likewise, if you
want a sample recorded every hour, you would enter 01:00:00, and the
days would default to zero.

Some sensors can take readings more often than once per second.  This is
known as a “continuous rate.”  Different sensors have different available
rates.

To use the continuous rate for a particular phase, enter the letter ‘c’ in the
polling interval rather than a specific time interval.  The sensor will then use
the rate that had been saved on the sensor using the Sensor Continuous
Rate option on the Configure menu.

• Enter the number of records to record at this polling interval.

• Press the Tab key and continue entering phases, as desired.
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Figure 11: Batch Session Profile Window

You can load and modify a saved profile or create a new one. If you want to open a
previously saved session profile, Click the Open button, and then navigate to the saved
profile.

Session ID: Enter a name for your session. This name will be part of the final uploaded
name – see details on file naming in the Uploading Sessions section below.

Delayed Start: If you want all your sensors to start at exactly the same time, enter a
delayed start time here. Be sure to select a time far enough in the future to allow the
session information to be broadcast to all sensors prior to that time. With directly
connected sensors, this time should not be more than a minute or two. With radio or
modem networks, this time may vary greatly. An error message will display if the session
information is not sent to all the sensors before the set delayed start time.

Set Sensor Clocks: Checkmark this box, if you want Aqua4Plus to reset the clocks on all
the sensors prior to starting the sessions. (The clocks will be set to the time on the
computer running Aqua4Plus. This is recommended, so that your collection times will
match from one sensor to another.)

Phase Information: Describe your session collection intervals and number of records, as
desired. (Note: if using a continuous interval, see Continuous Polling Interval below.)

Save As: If you want to save this profile to disk before loading to the sensors, click the
Save As button now.

Select Sensors: Once you have defined your profile, click the Select Sensors button.
This window will close and the batch processing window will display, as shown in
Figure 12.
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To stop the monitor, click the Stop button.

The Monitor displays a column for the sensor date/time and for each parameter being
collected. Use the horizontal and vertical scroll bars as needed to adjust the view.
Readings are displayed in the units selected from the Options Menu. For example,
pressure might be displayed in psi or in Ft  H2O, or something else. (See page 6 for
details on the Options Menu.)

Using Sessions

The Smart Sensor collects and stores data in “sessions.” A session is a preprogrammed
series of steps describing the number of samples to record and the sampling intervals.
Several sessions can be in the Smart Sensor memory at any one time, several completed
sessions (along with their data) and one active session. An active session can be either
recording, paused, or pending (waiting for a delayed start time). The maximum number of
sessions and the maximum number of records that can be stored depends on the type of
sensor. Check your sensor documentation for details.

The Session Profile Window is used to create and/or view session profiles. A session
profile is a description of the test steps necessary for a particular test. Session profiles
can be saved to disk for later use or downloaded to a sensor. Note: there can only be
one active session on a sensor. Once a new session is downloaded, any currently active
session is terminated and the new session becomes the active session. All previous
sessions on the sensor are retained, along with their data, until erased, but can not be
run again.

          Figure 6: Session Window
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Continuous Polling Interval
When using batch processing, the goal is to have each sensor record for the same amount of
time, with each phase lasting the same length of time from one sensor to the next. This makes
it easy to compare data from various different sensors.

Most AquiStar® Smart Sensors can be set to a continuous polling interval. This interval varies
from sensor to sensor and can be set on any particular sensor by selecting the Sensor Continu-
ous Rate under the Configure menu.

Due to the fact that sensors may have different continuous rates, if you want to set a phase in
your profile to be continuous in batch mode, you will need to specify the phase duration for
that phase, rather than specifying how many records will be recorded during that phase. The
minimum phase duration is 10 seconds.

To indicate that a phase is a continuous phase, enter a letter C in the polling interval. The
phase information will display as follows:

Enter the Phase Duration as dd/hh:mm:ss. When the session is downloaded to the sensor during
the starting process, the program will determine the correct number of records for that sensor
to record to match the phase duration you have set.

Batch Processing Window

Figure 12: Batch Session Start Window
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To view further details, click the ellipsis  in the upper right corner for a drop-down
information panel. Typical information for this drop-down panel may include:

Sensor Description: User assigned description. (Set this description on the
Configuration Menu | Sensor Description Option.)

Sensor Type: Factory assigned sensor type.

Modbus: This is the assigned Modbus address for the sensor.
Each sensor on a COM port must have a unique
Modbus address. This address must be between 1 and 255.
(Set this address on the Configure Menu | Sensor Address.)

Serial Number: Factory set sensor serial number.

Firmware Revision: Sensor firmware revision number.

Range/Element: Sensor range and element information may also be displayed.

Using the Real Time Monitor

Figure 5: Real Time Monitor

Use the Real Time Monitor (lower part of Sensor Window) to view live readings from the
sensor that is selected on the Sensor Tree. These readings are not being recorded in the
sensor, but only displayed for real time viewing. The Real Time Monitor can be used
whether or not the sensor is actively recording a session.

To obtain and display a single reading, click the Single button.

To obtain and display readings continuously for 60 readings, click the Start button.
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Be sure the sensors on which you want to start sessions are selected, and then click the
OK button. When you click OK, several things happen.

• Current status is gathered from each sensor.

• Available memory space is checked on each sensor.

• The clocks are reset (if so specified in profile).

• The profile information is downloaded to each sensor.

• The Start command is issued to each sensor.

Progress information for each sensor will be listed in the status column and overall
progress information will be shown in bold lettering at the lower left of the window.

Notes:
• If you checked the Set Sensor Clocks option in the profile, all sensor clocks will be

set to the current time on the computer running Aqua4Plus just before the session
is started. All clocks will be set at the top of a second. When using a radio or
modem network, there will be a communication time lag. It is to be noted that the
clocks may not be as closely synchronized as when this command is sent via a
direct connection.

• If you selected a delayed start time in the profile, all session profiles will be sent to
the sensors, and the sessions will start at the appointed times. If the appointed time
has passed before all the profiles have been loaded to the sensors, an error will be
generated. See Error Reporting on next page.

• If you did not select a delayed start time, each sensor will be started in turn at the
top of the next second. When directly connected, this results in each sensor
starting one second after the previous one. When using a radio or modem network,
the delay between session starts on the sensors will be somewhat more. If it is
important that the sessions start at the same time, you must use the delayed start
feature.

When the operation is finished, the status column will display the result of the operation
for each sensor. If the sessions were started successfully, the status column will say
Session Started, and the number of sessions on the sensors will be updated. Click the
Close button to exit the batch processing window.

Figure 13: Sessions Successfully Started
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Note that the information shown on the Sensor Tree and the Sensor Panel is static
information. In other words, the program looks at the sensor and displays the informa-
tion, but it does not keep going back to the sensor and getting the newest information.
This is to save battery life on the sensor. To update the information on the Sensor Tree
and the Sensor Panel, click on the “Refresh Selected Sensor” button below the Sensor
Tree. This will requery that particular sensor and update the display.

Sensor Tree:
The Sensor Tree displays a list of all sensors connected to the selected port. If no port
is selected or no sensors are connected to that port, this tree will be empty. The Sensor
Tree is an expanding tree display. Double-click on a sensor to expand the display to
show all sessions, if any, currently stored on that sensor. Click on the  to the left of a
sensor to hide the display of sessions for that sensor.

The different icons in front of each session indicate the current status of that session,
as follows:

   Completed Session - session has run to completion or has been terminated.
   Paused  Session - session has been paused by operator.
   Pending Session - session awaiting a delayed start time.
   Active Session - session currently recording.

Sensor Information Panel:

The top right portion of the Sensor Window displays information pertaining to the
sensor that is selected on the Sensor Tree. This information will vary, depending on the
type of sensor selected. Typical information may include:

Status: Active - sensor is currently recording.
Paused - a recording session has been paused.
Pending - a recording session is awaiting a delayed start

time.
Inactive - No active, paused, or pending sessions.

Sessions: Number of data sessions stored on selected sensor.
Maximum of 60.

Power: Battery or Auxiliary.

Free: Approximate number of records that can be stored
before the sensor memory is full.  Total number of records
varies by sensor type.

Battery: Battery indicator - if Green, the battery is good, if
Yellow, it is low, if Red, it is critically low.  When connected to
auxilliary power, this indicates the battery level of the internal
batteries, not the auxilliary power.
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Error Reporting

If any error occurred during the operation, a message box will display at the end of the
operation. Also, the affected sensor will display in red and an error message will display
in the status column. If you want to try again, select the desired sensors, and then click
the OK button; if not, click the Cancel button.

Uploading Sessions

The batch upload operation uploads the last session on each sensor that is selected in
the batch processing window.

To upload sessions from a group of sensors, select Batch Operations from the Session
menu, and then click on Batch Session Upload.

The following batch processing window will display.

Figure 14: Error in Starting Sessions

Figure 15: Batch Upload Window
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Normal Operation

Selecting a Communication Port

Aqua4Plus communicates with the smart sensors via a COM or a USB port on the PC.
When Aqua4Plus is first opened, it polls the computer for all available communication
ports. These are then listed in the connection port drop-down box on the tool bar (figure
3). By default, Aqua4Plus looks for USB and COM 1 through COM 4. If you are using a
higher COM port, specify the highest COM port on the Communications dialog box
under the Options menu.

To select the port you  are using, click on the down arrow, and then click on the port to
which your sensor is connected.

Figure 3: Connection Port Drop-Down Box

Finding, Selecting, and Viewing Sensors

Once the port has been selected, open the Sensor Window by clicking the  tool
button  (or View Menu | Sensor Window). The software will poll the port, looking for
any connected sensors.  A list of connected sensors will appear on the Sensor Tree. If
specific expected sensors do not show up, and you know their addresses, rescan just
those addresses by selecting “Scan Specific Address Range” from the View Menu.

On the Sensor Tree (figure 4), double-click to select a sensor. A list of data sessions
stored on the sensor will be displayed below the sensor. Information regarding the
selected sensor will display in the Sensor Information Panel to the right of the Sensor
Map.

                              Figure 4: Sensor Tree and  Sensor Information Panel

Click here to get
additional details, as
shown below.
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Be sure the sensors from which you want to upload are selected, and then click the OK
button.

You will be asked to select a file folder in which to save your uploaded files. The default
is the folder you have selected as your default folder under the Options menu.

As the files are uploaded, they are named as follows:

sensorname_sessionname_serialnumber.a4d

where:
sensorname = the name you have given to the sensor with the

Sensor Description option under the Configure menu.
sessionname = the name of the session being uploaded
serialnumber = the serial number of the sensor from which the

session is being uploaded.

For example, if you were uploading a session named Overnight from the three sensors
selected in the example above, your three files would be:

Pressure Well 17_Overnight_2901013.a4d
pH Well 17_Overnight_2902054.a4d
Conductivity Well 17_Overnight_2903021.a4d

If there is a session on the disk with the same name as the one you are trying to upload,
Aqua4Plus will check to see if it is actually an earlier upload of the exact same session. If
it is, then Aqua4Plus will upload only those records since that previous upload and
append them to the end of the file. If the file is from a different session, then an error will
be generated, and that file will not be uploaded so as to not overwrite any existing data
on your hard drive.

Progress information for each sensor will be listed in the status column and overall
progress information will be shown in bold lettering at the lower left of the window.

When the operation is finished, the status column will display the result of the operation
for each sensor. If the sessions were uploaded successfully, the status column will say
Session Uploaded.

Sessions are not stopped or erased during an upload operation. Click the Close button
to exit the batch processing window.
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Advanced

Download Firmware** - Downloads an updated version of the
firmware to the sensor, requires a
password. [Contact INW factory
personnel for details.]

Advanced Calibration* - Requires a password.  Contact INW factory
personnel for details.

Sensor Baud Rate*** - Sets alternate baud rate on sensor – 38400
(default), 19200, or 9600.

Direct Read Units*** - Use to set engineering units when not using
Aqua4Plus.

Radio - This option is only available on radios.  It is used
for setting radios as either remote or host.  Refer
to the WaveData Instruction Manual or contact
INW before using this option.

* Available to view but not change if there are any sessions stored on the sensor.

** Not available if there are any sessions stored on the sensor.

*** Not available on all sensors.
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Figure 16: Sessions Successfully Uploaded

If any error occurred during the operation, a message box will display at the end of the
operation. Also, the affected sensor will display in red and an error message will display
in the status column. If you want to try again, select the desired sensors, and then click
the OK button; if not, click the Cancel button.

Erasing Sessions

To erase sessions from a group of sensors, select Batch Operations from the Session
menu, and then click on Batch Session Erase.

The following batch processing window will display.

Be sure the sensors you want to erase are selected, and then click the OK button.

Figure 17: Batch Erase Window
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Configure Menu

Use the Configure Menu to set options on individual sensors. Note that not all options
will be available on all types of sensors. The program determines what sensor you are
connected to and lists configuration items available for that sensor. In order to access
items on the Configure Menu, you must first connect to and select the sensor whose
configuration you want to set. (See Finding, Selecting & Viewing Sensors, page 10.)

Sensor Clock* - A pop-up box displays the date/time currently in the
sensor. Click the Set From System Clock button to set
the sensor clock to match that of your host computer.
Alternately, type in a specific date/time and click the
Set Clock button.

Sensor Description* - Use to enter a description for a particular sensor.
This information is displayed on the Sensor
Window and is recorded with the collected data.

Sensor Address* - If you are connecting several sensors to one
COM port, each sensor must have a unique
address. This is also known as the Modbus address.
Use this option to set the address.

- Addresses must be between 1 and 255. Be sure to set
the Lowest and Highest Sensor Addresses to include all
addresses that you are using (see Options Menu |
Communication.)

Sensor Continuous - Some sensors can take readings more often than once
Rate* per second.  This is known as a “continuous rate.”

Different sensors have different available rates.  Use this
option to select the rate you want to use.  This rate will
be saved to the sensor.

- See the “Creating Session” section on how to set a
continuous rate session.  If this option is not available,
then that sensor does not have continuous rate func-
tionality.

Erase All Sessions - Erases ALL sessions in the currently selected
sensor.

Field Calibration* - Use this option to adjust the calibration on the sensor.
Note that different types of sensors will have different
calibration procedures. Refer to the specific sensor
manual for information on field calibration for that
sensor.
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Progress information for each sensor will be listed in the status column and overall
progress information will be shown in bold lettering at the lower left of the window.

When the operation is finished, the status column will display the result of the operation
for each sensor. If the sessions were erased successfully, the status column will say
Erased, and then number of sessions on the sensors will display as zero. Click the Close
button to exit the batch processing window.

If any error occurred during the operation, a message box will display at the end of the
operation. Also, the affected sensor will display in red and an error message will display
in the status column. If you want to try again, select the desired sensors, and then click
the OK button; if not, click the Cancel button.

Figure 18: Sessions Successfully Erased
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Figure 2: Communication Options

Change Password - Change the password that is required to enter the
Advanced Setup Menu.

Log Communication
Errors to File - This option turns on error logging.  A file will be kept of all

communication errors.  This log will be saved in the
Default Folder, as chosen under the Options Menu.

Font Size - Use this to increase or decrease the font size on the
sensor tree and the Real Time monitor.
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Appendix B: Using a USB Port

If you do not have or do not want to use a 9-pin serial port for connecting your
sensor to your PC, you can connect to a sensor using a USB port.

Connecting with INW’s USB to RS485 Adapter

If using INW’s USB to RS485 adapter, connect as shown in figure below. Drivers and
installation instructions come with the adapter.

Connection using INW’s USB to RS485 Adapter

Connecting with a USB to Serial Adapter

USB-to-Serial cables are readily available from many electronics and computer stores, as
well as numerous sites on the Internet. INW has tested and recommends the Keyspan
USA-19HS. It is available from INW as well as from many sites on the Internet. Install as
follows:

• Plug into USB port.

• Install the drivers provided with the particular unit.

• Determine the port number to which the adapter is assigned.
 Right-click on My Computer.
 From the popup menu, select Manage to open the Computer Management

window.
 On left panel, click on Device Manager.
 On right panel, double-click on Ports.
 A list of active COM ports will be displayed. Note the COM number assigned

to the adapter you just installed.

For example: 
 Close Manager.

• Connect to the sensor.

• On the Aqua4Plus software, select the COM port noted above. (If you do not see
your new COM port in the dropdown box, open the Communications dialog box
from the Options menu. Increase the Highest COM port number, up to a maximum
of 15.)

PC or Laptop
Computer

USB Port

USB to RS485
Adapter

Sensor
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First Time Setup

If you have just installed Aqua4Plus, please take a few minutes to go through the setup
options and configuration.

Options Menu
Use the Options Menu to control settings for the Aqua4Plus software. (Use the
Configure Menu, next page, to control settings for sensors.)

Display Units - Use this option to select the units in which to display
your data. This will control how data is represented on
the Real Time Monitor, the File Display Window, the
Graph Window, and for exported data.

Company Name - This name will print when printing from the File Display
window.

Default Folder - Aqua4Plus saves and looks for files in a default folder.
Use this option to select a default folder location.

Connections - This option is only available if you have a dial-up modem
enabled version of Aqua4Plus. See INW for
further details.

Communication - Use this to set the communications options for communi-
cating with the sensor.

A. From the dropdown Factory Suggested Settings box,
select the type of connection you are using.

B. Set the Lowest and Highest sensor addresses you will
be scanning.

C. If you are using a COM port higher than 4, increase the
Highest COM port to at least that high (maximum of
15).

All other settings will automatically adjust, and you will
rarely need to make changes unless instructed to do so in
a specific sensor / radio / or modem manual.
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Connection using a USB to Serial Adapter

PC or Laptop
Computer

USB Port

RS485/RS232
Adapter

Interface
Cable

Sensor

USB to Serial
Adapter

Reorder and Contact Information

For sales & service offices, please contact:

INWINWINWINWINW
www.inwusa.com

800-776-9355
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Installing the Aqua4Plus Software

1. Insert the Aqua4Plus CD in the CDROM drive on your PC or laptop. Installation
should start automatically. If not, then follow steps 2 and 3. Otherwise, skip to
step 4.

2. Click the Start button and select Run.
3. Type D:\setup.exe, where D: is the drive letter for your CDROM drive.
4. The Installation program will guide you through the installation process.

Once the software has successfully completed installation, you can remove the CD from
your CDROM drive and store it in a safe place.

To start the Aqua4Plus software, use the Start Menu to navigate to the program group
you selected during installation (typically this will be Aqua4Plus), and then click the

Aqua4Plus  icon.
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SOFTWARE LICENSE & LIMITED WARRANTY/DISCLAIMER
- Aqua4Plus

SOFTWARE LICENSE. The seller grants the user a non-exclusive license to use
Aqua4Plus (hereafter known as the software), according to the following limitations and
conditions.

The user may install  Aqua4Plus on one or more desktop or laptop computers. All title
and intellectual rights to the software are owned by the seller. No copies may be made or
distributed except as described above. The user may not modify or reverse engineer the
software.

A.   LIMITED WARRANTY. Seller warrants that the software will substantially perform
the functions described in the accompanying written materials for a period of ninety (90)
days from the date of receipt. If the software does not conform to the foregoing war-
ranty, Seller shall, at Seller’s sole and exclusive option, repair or replace the software or
refund to the user a prorated portion of the license fee paid.

Seller warrants that any hardware accompanying the software will be free from defects in
materials and workmanship under normal use and service for a period of one (1) year
from the date of receipt. Seller’s obligation under this warranty shall be limited to
replacing or repairing the part or parts or, at Seller’s option, the products which prove
defective in material or workmanship within ONE (1) year from the date of delivery,
provided that Buyer gives Seller prompt notice of any defect or failure and satisfactory
proof thereof.   Any defective part or parts must be returned to Seller’s factory or to an
authorized service center for inspection.   Buyer will prepay all freight charges to return
any products to Seller’s factory, or any other repair facility designated by Seller.   Seller
will deliver replacements for defective products to Buyer (ground freight prepaid) to the
destination provided in the original order.   Products returned to Seller for which Seller
provides replacement under this warranty shall become the property of Seller.

Seller’s obligations under this warranty shall not apply to any product with (a) is
normally consumed in operation, or (b) has a normal life inherently shorter than the
warranty period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written approval by
the Seller, all warranties are void.   Equipment and accessories not manufactured by the Seller are
warranted only to the extent of and by the original manufacturer’s warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES,
WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY.   IMPLIED
WARRANTIES OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.   SELLER’S
WARRANTY OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER (EXCEPT AS
TO TITLE) ARE SOLELY AND EXCLUSIVELY AS STATED HEREIN.   IN NO CASE WILL
SELLER BE LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR PERFORMED IN
CONNECTION WITH REMOVAL AND REPLACEMENT OF THE SENSOR SYSTEM,
LOSS OF PRODUCTION OR ANY OTHER LOSS INCURRED BECAUSE OF INTERRUP-
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Connecting a Sensor to the Computer

In its cabled configuration, the Smart Sensor cable is terminated with a weather
resistant connector.  In its cableless configuration, the sensor is terminated with a
screw-cap. Remove the screw-cap to access the weather resistant connector. Connect
the weather resistant connector to your PC or laptop serial port via the communication
cable and an RS485/RS232 adapter, as shown below. For USB connections, see
Appendix B.

Figure 1: Connecting a Sensor to the computer

PC or Laptop
Computer
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Serial Port
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TION OF SERVICE.   A NEW WARRANTY PERIOD SHALL NOT BE ESTABLISHED FOR
REPAIRED OR REPLACED MATERIAL, PRODUCTS OR SUPPLIES.   SUCH ITEMS
SHALL REMAIN UNDER WARRANTY ONLY FOR THE REMAINDER OF THE WAR-
RANTY PERIOD ON THE ORIGINAL MATERIALS, PRODUCTS OR SUPPLIES.

B.   With respect to products purchased by consumers in the United States for personal use, the
implied warranties including but not limited to the warranties of merchantability and fitness for a
particular purpose, are limited to twelve (12) months from the date of delivery.

Some states do not allow limitations on the duration of an implied warranty, so the above
limitation may not apply to you.   Similarly, some states do not allow the exclusion or limitation
of consequential damages, so the above limitation or exclusion may not apply to you.   This
limited warranty gives you specific legal rights; however, you may also have other rights which
may vary from state to state.
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